# Table of Contents

**Simple guide to installation** ....................................................................................................................... 2

**Detailed guide to installation** ...................................................................................................................... 4
- License server installation for Windows .............................................................................................................. 5
- License server installation for Macintosh .......................................................................................................... 9
- Troubleshoot license server installation ................................................................. 11
  - Handle a firewall on the license server machine ....................................................................................... 12
  - Troubleshoot license server authorization ............................................................................................. 14
  - Install on a machine with an existing SentinelLM network ................................................................. 19
  - Verify the Lasergene version number ..................................................................................................... 20
- Standalone and network client installation for Windows .................................................................................. 21
- Standalone and network client installation for Macintosh ............................................................................. 24
- Troubleshoot standalone and network client installation ........................................................................... 27
  - Run command prompt versions of DNASTAR software ........................................................................... 28
  - Troubleshoot client software authorization ............................................................................................ 29
  - Troubleshoot the error “A different version is running” ........................................................................ 30
  - Troubleshoot failure to launch SeqMan NGen ...................................................................................... 31
- Special types of installation ............................................................................................................................ 32
  - Install Lasergene quickly on multiple client machines .............................................................................. 33
  - Install and uninstall from the command prompt or Terminal ................................................................... 34
    - Install the license server on Windows .................................................................................................... 35
    - Install the license server on Macintosh .................................................................................................. 36
    - Install and uninstall the client & standalone software on Windows .................................................. 37
    - Install and uninstall the client & standalone software on Macintosh .................................................. 39
    - Authorize silently on Windows ......................................................................................................... 41
    - Authorize silently on Macintosh .......................................................................................................... 42
- Network license server administration ........................................................................................................ 49
  - Restart, stop and uninstall the license server ............................................................................................ 50
  - Verify license server status ...................................................................................................................... 51
  - Monitor how many licenses are checked out to whom ............................................................................ 52
  - Troubleshoot client access to the license server ..................................................................................... 54
    - Error message: “All licenses are in use” ............................................................................................ 55
    - Error message: “Cannot connect to License Server” .......................................................................... 56
Simple guide to installation

To install Lasergene as a standalone product:

1. Log in to your DNASTAR account and go to the My Licenses page. Press the appropriate button (Lasergene for Windows, Lasergene for Mac OS X) to download the standalone installer.

2. Run the installer, following the instructions on each screen. If prompted to authorize, choose Standalone and enter your 17- or 36-character product key, available on the My Licenses page.

To install Lasergene on a network:

Network installation involves two stages: installing the license server on host computer, and installing Lasergene on the client computers.

* If you have previously installed the license server on one host computer and need to move it to a different computer, please contact our support staff for help facilitating the transfer.

Part A: License server installation:

On the computer designated to run the Lasergene license server:

1. Log in to your DNASTAR account and go to the My Licenses page. Click the appropriate Network Server button (Server for Mac OS X, Server for Windows) to download the installer.
2. Run the installer, following the instructions on each screen. If the server machine uses a firewall, follow the instructions in Handle a firewall on the license server machine. After the installation finishes, you may be asked to enter a product key for authorization. This key can be found on the My Account page.

3. Once authorized, a new LasergeneClient’x’ folder (where ‘x’ is the version number) will be placed on your server’s desktop. This folder contains:

   - A file named IP Address [x.x.x.x].txt – The IP address will be needed to activate Lasergene on the client computers.

   - Several *.lshost files – Needed for advanced installations.

   - An HTML file – Instructions for client installation.

Part B: Client installation:

On each of the computers that will be running Lasergene:

1. Log in to your DNASTAR account and go to the My Licenses page. Press the appropriate button to download the client installer (Lasergene for Windows, Lasergene for Mac OS X).

2. Run the client installer, following the instructions on each screen. When prompted, choose Network, and type in the IP address for the license server machine. (see section above).

For in-depth information on standalone and network/client installation, see Detailed guide to installation.

For detailed information on network maintenance and troubleshooting, see Network license server administration.
Detailed guide to installation

Though most users will only need our [Simple guide to installation](#), the following topics offer a more detailed walk-through of the installation process:

- Network license server installation for [Windows](#) and [Macintosh](#) ([troubleshooting](#))
- Standalone and network client installation for [Windows](#) and [Macintosh](#) ([troubleshooting](#))
- Special types of installation:
  - [Installing Lasergene quickly on multiple client machines](#)
  - [Installing and uninstalling from the command prompt or Terminal](#)
  - [Installing Lasergene on KeyServer systems](#)
  - [Installing ArrayStar on a Macintosh machine](#)
License server installation for Windows

The license server machine can be either a Macintosh or Windows computer and can serve any combination of Macintosh and Window client machines up to your license limit. Choose a machine that will always be turned on, accessible from your network, and which has a static IP address. Administrator privileges are required to perform license server installation.

This section explains in detail how to install and authorize the DNASTAR network license server software for on a Windows computer. If your server is a Macintosh computer, follow these instructions instead. If you will be performing a standalone installation rather than a network one, proceed to this topic instead.

To install the License server on a Windows computer:

1. **Log in** to your DNASTAR account and go to the My Account page. Click the Network Server button **Server for Windows** to download the installer.

2. Double-click on the DNASTAR Lasergene License Server Installer executable (*exe) file to initiate installation.

3. In the Welcome dialog, read the instructions, and then click **Next**.

4. In the License Agreement dialog, read the agreement and choose **I accept the agreement** if you accept (required for installation). Press **Next**.

4. In the Installation Directory dialog, click **Next** to install in the default location (C:\Program Files (x86)\DNASTAR-LicenseServer, or C:\Program Files\DNASTAR-LicenseServer for 32-bit machines). Otherwise, you may click the browse (folder) icon to install in a custom location. If you are upgrading from a previous Lasergene Network license server, the new version must be installed in the same directory as the previous version. Once the new version of the license server is installed, you will still be able to run previous network client versions during your client upgrade process. After choosing a location, click **Continue**. Then click **Next**.
5. In the Select Components dialog, you can highlight a component to display information about it in the area to the right. Leave both Components boxes checked and click Next.

6. In the Important Notes dialog, read the information and press Next.

7. In the Ready to Install dialog, click Next to initiate installation.

8. If a license for the current version of the License Server is not detected, the License Server
Authorization dialog will open. Enter your alphanumeric product key into the License field, and then click Authorize. Your license key is shown in the My Account page of the DNASTAR website.

![DNASTAR License Server Authorization dialog](image)

9. A progress bar will be displayed. When you receive a message that authorization was successful, click OK.

After authorizing the software, the following events will occur:

- A new folder named LasergeneClient'x' (where 'x' is the version number) will appear on the desktop. The detected IP Address of the server computer, required for network client installation, can be found in this folder as a file named IP Address [x.x.x.x].txt.

- A browser window entitled Installing Lasergene Software on Client Computers will open. This page provides information and links for installing the DNASTAR Lasergene network client. The page can be re-opened later from the LasergeneClient'x' directory by double-clicking on Lasergene Installation.html.

Having issues with this procedure? Check out these troubleshooting topics:

- Handle a firewall on the license server machine
- Troubleshoot license server authorization
- Install on a machine with an existing SentinelLM network
• **Verify the Lasergene version number**

Otherwise, proceed to [Standalone and network client installation for Windows](#) or [Macintosh](#).
License server installation for Macintosh

The license server machine can be either a Macintosh or Windows computer and can serve any combination of Macintosh and Window client machines up to your license limit. Choose a machine that will always be turned on, accessible from your network, and which has a static IP address. Administrator privileges are required to perform license server installation.

This section explains in detail how to install and authorize the DNASTAR network license server software for on a Macintosh computer. If your server is a Windows computer, follow these instructions instead. If you will be performing a standalone installation rather than a network one, proceed to this topic instead.

To install the License server on a Macintosh computer:

1. **Log in** to your DNASTAR account and go to the **My Account** page. Click the Network Server button **Server for Mac OS X** to download the installer.

2. Double-click on the **Lasergene ‘x’ License Server Mac Install** disk image (.dmg) to open a window containing the application (.app). Then double-click on .app file to launch the installer.

3. In the Welcome dialog, read the instructions, and then click **Next**.

4. In the License Agreement dialog, read the agreement and choose **I accept the agreement** if you accept (required for installation). Press **Next**.

5. In the Important Notes dialog, follow the on-screen instructions and click **Next**.

6. In the Ready to Install dialog, press **Next**.

7. If a license for the current version of the License Server is not detected, the License Server Authorization dialog will open. Enter your alphanumeric product key into the **License Server Product Key** field, and then click **Authorize** to initiate installation.
8. A progress bar will be displayed. When you see a notification that installation has completed successfully, click **Close**.

After authorizing the software, the following events will occur:

- A new folder named *LasergeneClient'x'* (where 'x' is the version number) will appear on the desktop. The detected IP Address of the server computer, required for network client installation, can be found in this folder as a file named *IP Address [x.x.x.x].txt*.

- A browser window entitled **Installing Lasergene Software on Client Computers** will open. This page provides information and links for installing the DNASTAR Lasergene network client. The page can be re-opened later from the *LasergeneClient'x'* directory by double-clicking on *Lasergene Installation.html*.

Having issues with this procedure? Check out these troubleshooting topics:

- [Handle a firewall on the license server machine](#)
- [Troubleshoot license server authorization](#)
- [Install on a machine with an existing SentinelLM network](#)
- [Verify the Lasergene version number](#)

Otherwise, proceed to [Standalone and network client installation for Windows](#) or [Macintosh](#).
Troubleshoot license server installation

- Handle a firewall on the license server machine
- Troubleshoot license server authorization
- Install on a machine with an existing SentinelLM network
- Verify the Lasergene version number
Handle a firewall on the license server machine

If the server computer's firewall is “on,” you will need to allow an exception for the DNASTAR lserv (Macintosh) or lservnt.exe (Windows) file. In most cases, this exception is set up automatically during installation.

To set up the exception manually:

**On Windows:**

1. Determine whether a firewall is present by navigating to the Control Panel and searching for Windows Firewall. Note whether the firewall is On or Off.

2. If the firewall is On, check whether there is an exception for Sentinel RMS Development Kit License Manager (the name of the license manager software used by DNASTAR).

3. If no exception is listed, follow Microsoft's instructions for adding a program to the firewall. When prompted to choose a program path, use the Browse button to navigate to C:\Program Files (x86)\DNASTAR-LicenseServer\Server\lservnt.exe.

4. In the “allowed programs” dialog, check all of the boxes (Domain, Private, and Public) corresponding to Sentinel RMS Development Kit License Manager.

5. Click OK to save your changes and exit.

**On Macintosh:**

1. Determine whether a firewall is present by navigating to System Preferences > Security and Privacy and clicking on the Firewall tab. Note whether the firewall is On or Off.

2. If the firewall is On, check whether there is an exception for lserv.

3. If no exception is listed, click the Firewall Options button and follow Apple's instructions for adding a program to the firewall. The “allowed programs” dialog should now say that lserv is set to Allow all incoming connections.
4. Click **OK** to save your changes and exit.
Troubleshoot license server authorization

After Network License Server Installation, you will be prompted to authorize the license server software using this dialog:

If you enter unrecognized information and click Authorize, you may receive one of the error messages shown in the table on the next page. To address the issue, click the OK button in the error message. This returns you to an enhanced version of the original authorization dialog:

You can also launch the enhanced version of the License Server Authorization dialog using either of the following methods.

• In the License Server Product key field, use either an asterisk (*) or xxxx-xxxx-xxxx in place of the product key.
• On Windows, press Ctrl+Alt+[Back button]; on Macintosh, press Option+Cmd+[Back button].

Correct your earlier entry using the solution in the table below, then again click Authorize.

<table>
<thead>
<tr>
<th>If you received this error message…</th>
<th>…try this solution:</th>
</tr>
</thead>
<tbody>
<tr>
<td>There appear to be no keys currently authorized for the product key, product, or version number provided. If you feel that this is in error, please contact DNASTAR.</td>
<td>• If authorizing the license server, ensure you are using the license server License Manager located in the C:\Program Files (x86)\DNASTAR-LicenseServer\Server folder.</td>
</tr>
<tr>
<td></td>
<td>• If authorizing the Client, verify that you are using the Client License Manager available through the Navigator or in the CFiles (x86)\DNASTAR\License Manager directory.</td>
</tr>
<tr>
<td></td>
<td>• If you have both Macintosh and Windows product keys, verify the key matches the platform on which you are authorizing.</td>
</tr>
<tr>
<td></td>
<td>• If you have had previous versions of the software, verify that you are using the product key for the current version of the software.</td>
</tr>
<tr>
<td>The key you entered is for a network license and cannot be used to authorize a standalone client.</td>
<td>Check that you have entered the product key correctly, and that it is the appropriate key and type (Standalone/Client vs. Network) for the Lasergene application and version that you are installing.</td>
</tr>
</tbody>
</table>

If you receive the error message again, you may wish to perform a manual authorization.

- Manual authorization is only for the license server and Standalone versions of Lasergene, and does not apply to Client installations.

1. In the enhanced version of the License Server Authorization dialog (see above), click the Manual button.

2. In the “Step 1 of 4” dialog, click the Copy Computer ID button to copy the unique ID number to your computer’s clipboard. Then click Next.
3. In the “Step 2 of 4” dialog, click the **Launch Browser** button.

The browser opens to the DNASTAR License Server Authorization web page.
• Insert the cursor in the **Your Computer ID** field. To insert the ID that was stored in your clipboard, use **Ctrl/Cmd+V**, or right-click and choose **Paste**.

• Open the DNASTAR **My Licenses** page. Copy your Product Key, then return to the Manual Authorization page and paste it into the **Product Key** field.

4. Click **Submit**. An additional section appears on the Manual Authorization page. Checkmarks denote the applications that will be installed.

5. (optional) If you do not want to install a particular application, remove the checkmark next to its name.

6. Press **Activate**. If activation was successful, a block of License Text will appear.

7. Highlight all the text under "License Text:*" and above the line “For assistance...”. Copy the text into your clipboard using *Ctrl/Cmd+C*, or by right-clicking and choosing **Copy**.
8. Go back to the Manual DNASTAR License Server Authorization dialog and click **Next**.

9. Click **Paste License Text** to paste the copied text into the License Text field.

10. Click **Finish**. If authorization was successful, you will receive a message.
Install on a machine with an existing SentinelLM network

You can run a DNASTAR network if you already have a SentinelLM network running for another program. If you already have a SentinelLM network running on the same server where you want to install the DNASTAR license server, you will simply need to combine the license files for both programs.
Verify the Lasergene version number

This topic applies only to network installations.

In order to allow companies to run previous network client versions during the client upgrade process, we retained the original license server feature names of Lasergene 6, SeqBuilder 6, SeqMan 6, etc. As a result, you will always see “Lasergene 6” in the feature list on the server. A quick way to verify you have installed the most recent version of Lasergene is to open the LasergeneClient’x’ folder (where ‘x’ is a number) and look at the version numbers of the .lshost files.
Standalone and network client installation for Windows

This section explains how to install DNASTAR Lasergene as a network client working in tandem with a DNASTAR license server. These instructions apply to all locally-installed DNASTAR applications. Administrator privileges are required to perform this installation. If you will be installing on Macintosh, use these instructions instead.

Before starting the steps below, be sure to:

- Close all existing DNASTAR software.
- (Network client installation only) Follow all steps for the Network license server Installation on Windows or Macintosh.

To perform standalone or network client installation on Windows:

1. Log in to your DNASTAR account and go to the My Account page. Press Lasergene for Windows to download the standalone/network client installer.

2. Double-click on the DNASTAR Lasergene Installer executable (*.exe) file to initiate installation.

3. Follow the instructions in the DNASTAR Lasergene Installer screen, and then click Next.

4. Read the agreement in the License Agreement screen. If you agree with the terms (required for installation), select the I accept the agreement button, and then click Next.

5. In the Installation Directory screen, click Next to install in the default location (recommended). Otherwise, click on the folder icon to select a non-default location for the installation.
6. In the Ready to Install screen, click **Next**. You will see a progress bar showing the progress of the installation.

   ![Installation Directory](image)

   **Note:** If you cancel an installation in progress, you will be asked to confirm the cancellation. If you respond **Yes**, a second popup will ask if you would like to file a technical support request to get help with the installation. Clicking **Yes** in this dialog will take you to the DNASTAR website’s Technical Support Request page.

7. If a license for the current version of Lasergene is not detected, the Lasergene Authorization dialog will open.

   ![Lasergene Authorization](image)

   - If you are performing a **standalone** installation, select **Standalone** and enter your **Product Key**.
Your Product Key can be found on your My Licenses page of the DNASTAR website. (If you cannot find the key there, please contact us). Press the Authorize button.

• If you are installing client software as part of a network installation, and the correct *.Ishost files are in the same directory as the installer executable, you will not be prompted to license the software. Otherwise, select Network and enter the License Server’s Hostname or IP address in the text box. The IP Address can be found in the LasergeneClient‘x’ folder created on the host computer’s desktop during License Server installation. Click the Authorize button.

• If you do not wish to authorize at this time – Press Cancel and open the authorization dialog at a later time by launching Navigator and choosing License Manager from the Utilities section. If you authorized the software using a recognized key, you will receive a message containing an OK button Press OK to continue the installation.

If you receive an Unable to authorize message when installing a network client, see Troubleshoot license server authorization.

8. When installation is complete, press Finish. The DNASTAR Navigator will launch automatically.

The installed Lasergene applications can now be accessed via the DNASTAR Navigator or the DNASTAR Lasergene ‘x’ folder in the Start menu.
Standalone and network client installation for Macintosh

This section explains how to install DNASTAR Lasergene as a network client working in tandem with a DNASTAR license server. These instructions apply to all locally-installed DNASTAR applications. Administrator privileges are required to perform this installation. If you will be installing on Windows, use these instructions instead.

Before starting the steps below, be sure to:

1. Close all existing DNASTAR software.
2. (Network client installation only) Follow all steps for the Network license server Installation on Windows or Macintosh.

To perform standalone or network client installation on Macintosh:

1. Log in to your DNASTAR account and go to the My Account page. Press Lasergene for Mac OS X to download the standalone/network client installer.

2. Double-click on the disk image (.dmg) to open a window containing the installer app (.app). Then double-click on the installer app to launch the installer.

3. Follow the instructions in the DNASTAR Lasergene Installer screen, and then click Next.

4. In the License Agreement dialog, read the agreement. If you agree to the terms (required for installation), select I accept the agreement and then press Next.

5. In the Installation Directory screen, click Next to install in the default location (recommended). Otherwise, click on the folder icon to select a non-default location.
6. In the Ready to Install screen, click **Next**. You will see a progress bar showing the progress of the installation.

**Note:** If you cancel an installation in progress, you will be asked to confirm the cancellation. If you respond **Yes**, a second popup will ask if you would like to file a technical support request to get help with the installation. Clicking **Yes** in this dialog will take you to the DNASTAR website’s **Technical Support Request page**.

7. If a license for the current version of Lasergene is not detected, the Lasergene Authorization dialog will open.

   • If you are performing a **standalone** installation, select **Standalone** and enter your **Product Key**. Your Product Key can be found on your **My Licenses** page of the DNASTAR website. (If you cannot find the key there, please [contact us](#)). Press the **Authorize** button.
• If you are installing client software as part of a network installation, and the correct *.lshost files are in the same directory as the installer app, you will not be prompted to license the software. Otherwise, select Network and enter the License Server’s Hostname or IP address in the text box. The IP Address can be found in the LasergeneClient\’x’ folder created on the host computer’s desktop during License Server installation. Click the Authorize button.

• If you do not wish to authorize at this time – Press Cancel and open the authorization dialog at a later time by launching Navigator and choosing License Manager from the Utilities section.

If you used a recognized key, you will receive a message containing an OK button Press OK to continue the installation.

If you receive an Unable to authorize message when installing a network client, see Troubleshoot license server authorization.

8. When installation is complete, press Finish. The DNASTAR Navigator will launch automatically.

The installed Lasergene applications can now be accessed via the DNASTAR Navigator or the /Applications/DNASTAR folder.
Troubleshoot standalone and network client installation

- Run command prompt versions of DNASTAR software
- Troubleshoot client software authorization
- Troubleshoot the error
- Troubleshoot failure to launch SeqMan NGen
Run command prompt versions of DNASTAR software

After installing and licensing SeqNinja (sometimes called DNA*) and/or SeqMan NGen, they can be run immediately from the Navigator, or from the DNASTAR Lasergene ‘x’ folder in the Start menu (Win) or the Applications folder (Mac), without restarting the client machine.

For Windows users only: If you want to run the xng, sng, qng or seqninja applications through the command prompt and the path to these items is not present (i.e., from an earlier installation), you may first need to log off and log back in again on the standalone or client machine.
Troubleshoot client software authorization

This topic applies only to network installations.

The authorization key for Lasergene network client software is the IP address of the license server computer. If you are the end user, please contact your system administrator for this information.

If you are the system administrator, you can find the license server’s IP address by opening the LasergeneClient’x’ folder (where ‘x’ is the version number) located on the desktop. The number in the file name IP Address [x.x.x.x].txt is the authorization key for the network clients.

To allow uninterrupted communication between the client software and the License Server, you must install the DNASTAR License Server on a computer with a static IP address. If the License Serve’s IP address does change after installation, see License server’s IP address has changed.
Troubleshoot the error “A different version is running”

If you receive the error "A different version of Lasergene is running" when you try to launch a Lasergene application, but another version of Lasergene actually isn't running, there may be a lingering .state file from another version that needs to be deleted.

The solution is to locate and delete files named STARDM*.state, …where “*” represents the version number. These files may exist in the following directories:

Windows:

- C:sers\username\AppData\Local\DNASTAR\DataManager
- C:\ProgramData\DNASTAR\DataManager

Macintosh:

- Hard Drive:Library:Preferences:DNASTAR:DataManager
- Hard Drive:Users:username:Library:Preferences:DNASTAR:DataManager

If you find any of the .state files listed above, delete them. Once the files are deleted, the error should no longer appear.
**Troubleshoot failure to launch SeqMan NGen**

If Windows users attempt to launch SeqMan NGen without an updated .NET Framework Service Pack 1 installed, they may receive an error message and SeqMan NGen may fail to open.

Windows users can resolve this issue manually by downloading and installing .NET Framework 4.7.2 or higher. The best way to ensure the correct software is installed is to perform all recommended updates when prompted by your operating system.
Special types of installation

The following topics deal with special types of installation:

• Install Lasergene quickly on multiple client machines

• Install and uninstall from the command prompt or Terminal

• Install Lasergene on KeyServer systems

• Install ArrayStar on a Macintosh machine
Install Lasergene quickly on multiple client machines

This topic applies only to network installations.

Normal network client installation requires following the steps in the Standalone and network client installation (Windows / Macintosh) for each client machine.

Advanced installation lets you distribute a folder containing a preconfigured Lasergene installation to computers on your network, allowing quick installation on multiple machines.

1. On Macintosh only, double-click on the disk image (.dmg) to open a window containing the installer app (.app). For both Macintosh and Windows, move the executable file (.exe) or installer app (.app) to the LasergeneClient\x’ folder, adjacent to these three files: LG\x’.Ihost, NG\x’.Ihost, AS\x’.Ihost.

2. Copy the entire LasergeneClient\x’ folder to a USB drive or a shared network drive that can be accessed by each client.

3. You may now run the DNASTAR Lasergene Installer for Macintosh or Windows on each of the client machines. Be sure to run the installer from the LasergeneClient\x’ folder to ensure that the *.Ihost files are automatically recognized by the installer.
Install and uninstall from the command prompt or Terminal

Instead of performing a traditional installation, you may optionally install and/or uninstall DNASTAR software from the command prompt (Win) or Terminal (Mac). This type of “silent” installation/uninstallation does not require user interaction. Installation runs in the background, without any dialogs or notifications.

- **Win:** Instructions for installing the License Server and standalone/client software. If you do not authorize at the time of installation, you may authorize silently at a later time.

- **Mac:** Instructions for installing the License Server and standalone/client software. If you do not authorize at the time of installation, you may authorize silently at a later time.
Install the license server on Windows

As an alternative to traditional License Server installation, you may also install the DNASTAR License Server from the Windows command prompt:

1. Download the network installer executable `DNASTAR\x\LicenseServerWinInstaller.exe` (where 'x' denotes the version number).

2. On the network host machine, open a command prompt.

3. Drag the installer executable into the command prompt to add the path. After the path, type a space and the following text:

   ```
   --mode unattended --dnastarProductKey xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx
   ```

   In place of the "x's," use the alphanumeric string from the My Licenses page of the DNASTAR website.

   Example of the final command:

   ```
   C:\Users\<username>\Desktop\DNASTAR1500LicenseServerWinInstaller.exe --mode unattended --dnastarProductKey xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx
   ```

4. Press Enter. If a security warning appears, choose Yes.

A folder named `LasergeneClient\x` will appear on the desktop. This folder contains the `.Ishost` files you will need to set up the clients.
Install the license server on Macintosh

As an alternative to traditional License Server installation, you may also install the DNASTAR License Server from the Macintosh Terminal:

1. Download the network installer executable DNASTARx'LicenseServerMacInstaller.dmg (where ‘x’ denotes the version number). Double-click on the disk image (.dmg) to open a window containing the installer app (.app).

2. On the network host machine, open the Terminal.

3. Right-click on the installer app and choose Show Package Contents. Open the Contents directory and then the MacOS directory. Drag the file installbuilder.sh into the Terminal to add the path. After the path, type a space and the following text:

   --mode unattended --dnastarProductKey xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx

   In place of the “x’s,” use the alphanumeric string from the My Licenses page of the DNASTAR website.

   Example of the final command:

   /Volumes/DNASTAR\ License\ Server/DNASTAR\ 15.0.0\ License\ Server\ Mac\ Installer.app/Contents/MacOS/installbuilder.sh --mode unattended --dnastarProductKey xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx

4. Press Enter. If a security warning appears, choose Yes.

A folder named LasergeneClient’x’ will appear on the desktop. This folder contains the .lshost files you will need to set up the clients.
Install and uninstall the client & standalone software on Windows

To install:

As an alternative to the traditional method of installing standalone or network client software, you can use the Windows command prompt to perform the installation “silently”:

1. Download the standalone/client installer DNASTARLasergene’x’WinInstaller.exe (where ‘x’ represents the version number).

2. (network installation only) Move the standalone/client installer into the _LasergeneClient’x’_folder that was created during License Server installation. Then copy the entire folder to the desktop of the client machine.

3. On the machine where the standalone/client software will be installed, open a command prompt.

4. Drag the installer executable into the command prompt to add the path. After the path, type a space, then add this text:

   If you are using a standalone key, add:

   ```
   --mode unattended --dnastarProductKey xxxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx
   ```

   In place of the “x’s,” use the alphanumeric string from the My Licenses page of the DNASTAR website.

   If you are using an IP address, add:

   ```
   --mode unattended --dnastarServerIP xx.xx.x.xxx
   ```

   In place of the “x’s,” use the IP address specified in the _LasergeneClient’x’_folder.

Example of the final command:

```
C:\<username>\Desktop\DNASTARLasergene150aWinInstaller.exe --mode unattended --dnastarServerIP 55.55.555
```
5. Press Enter. If a security warning appears, choose Yes.

To uninstall:

Open a command prompt and run the following command:

```
"C:\Program Files (x86)\DNASTAR\Uninstall Lasergene 'x'.exe" --mode unattended
```

... where 'x' represents the version number.
Install and uninstall the client & standalone software on Macintosh

To install:

As an alternative to the traditional method of installing standalone or network client software, you can use the Macintosh Terminal to perform the installation “silently”:

1. Download the standalone/client installer DNASTARLasergene’x’MacInstaller.dmg (where ‘x’ represents the version number). Double-click on the disk image (.dmg) to open a window containing the installer app (.app).

2. (network installation only) Move the standalone/client installer app into the _LasergeneClient’x’_folder that was created during License Server installation. Then copy the entire folder to the desktop of the client machine.

3. Open the LasergeneClient’x’ folder, right-click on the .app file and choose Show Package Contents. Navigate to Contents*/MacOS. You should see a file named installbuilder.sh.

4. On the machine where the standalone/client software will be installed, open the Terminal. Drag the installbuilder.sh file and drop it into the Terminal to provide the path. After the path, type a space, then add this text:

   If you are using a standalone key, add:

   --mode unattended --dnastarProductKey xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx

   In place of the “x’s,” use the alphanumerical string from the My Licenses page of the DNASTAR website.

   If you are using an IP address, add:

   --mode unattended --dnastarServerIP xx.xx.x.xxx

   In place of the “x’s,” use the IP address specified in the _LasergeneClient’x’_folder.

Example of the final command:
/Volumes/DNASTAR\ Lasergene\ 15/DNASTAR\ Lasergene\ Installer.app/Contents/MacOS/ installbuilder.sh --mode unattended --dnastarServerIP 55.55.5.555

5. Press **Enter**. If a security warning appears, choose **Yes**.

**To uninstall:**

Open the Terminal and run the following command:

```
"/Applications/DNASTAR/Uninstall Lasergene 'x'.app/Contents/MacOS/installbuilder.sh" --mode unattended
```
Authorize silently on Windows

If you did not authorize a client or standalone installation at the time of installation, you can do so at any time by launching the Navigator and clicking on **License Manager**, located in the Utilities Section.

To instead authorize the Lasergene software silently, follow these instructions:

1. On the machine where the standalone/client software was installed, open a command prompt.

2. Drag the installer executable into the command prompt to add the path. After the path, type a space, then add this text:

   *If you are using a standalone key, add:*

   ```
   -q -k xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx
   ```

   In place of the “x’s,” use the alphanumeric string from the [My Licenses](#) page of the DNASTAR website.

   *If you are using an IP address, add:*

   ```
   -q -l xx.xx.x.xxx
   ```

   In place of the “x’s,” use the IP address specified in the LasergeneClient’s folder.

*Example of the final command:*

"C:\Program Files (x86)\DNASTAR\Lasergene 15\DNASTAR\LicenseManager.exe" -q -l
55.55.5.555
Authorize silently on Macintosh

If you did not authorize a client or standalone installation at the time of installation, you can do so at any time by launching the Navigator and clicking on License Manager, located in the Utilities Section.

To instead authorize the Lasergene software silently, follow these instructions:

1. On the machine where the standalone/client software was installed, open the Terminal.

2. Drag the installer app into the Terminal to add the path. After the path, type a space, then add this text:

   If you are using a standalone key, add:

   `-q -k xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx`

   In place of the “x’s,” use the alphanumeric string from the My Licenses page of the DNASTAR website.

   If you are using an IP address, add:

   `-q -l xx.xx.x.xxx`

   In place of the “x’s,” use the IP address specified in the LasergeneClient’x’ folder.

Example of the final command:

```
/Applications/DNASTAR/Lasergene\ 15/DNASTARLicenseManager.app/Contents/MacOS/LicenseManager -q -l 55.55.5.5
```
Install Lasergene on KeyServer systems

This topic applies only to network installations.

Lasergene 16.0 and higher versions support KeyServer 7.5 and 7.6. The following instructions explain how to set up the Lasergene license server and client for KeyServer. This installation requires the following files, which you should have received in an email from DNASTAR: Lasergene.lic, ArrayStar.lic and NGen.lic; LG’x’’.keyhost, AS’x’’.keyhost and NG’x’’.keyhost, where ‘x’ represents the version number.

On the KeyServer host machine:

1. Copy all of the .lic files you received to the following folder:
   - Windows: C:\Program Files\Sassafras K2\Server\KeyServer Data
   - Mac: Applications/Sassafras K2/Server/KeyServer Data

2. Restart the KeyServer service as described in your KeyServer instructions.

3. Create a folder on the desktop (e.g., LasergeneClient).

4. Copy all of the .keyhost files you received into the new folder.

5. Log in to your DNASTAR account and go to the My Account page. Press the appropriate button to download the client installer (Client for Mac OS X, Client for Windows).

6. (Macintosh only) Double-click on the disk image (.dmg) to open a window containing the installer app (.app).

7. (all platforms) Move the executable file (.exe) or installer app (.app) into the new folder with the copies of the .keyhost files.
8. Move a copy of the folder to each of the client machines.

On each of the client machines:

Install the Lasergene client software as described in Simple guide to installation or Detailed guide to installation.

Troubleshooting:

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>When attempting to launch a DNASTAR application on the KeyServer network, the error “Debug String” appears</td>
<td>A “Debug String” error can occur when you or an administrator uses Sassafras KeyConfigure to key or patch a DNASTAR application. DNASTAR applications require a vendor-generated license and may not launch successfully after being modified in this way. To prevent this problem, please use only the license file provided by DNASTAR for running DNASTAR applications on a KeyServer network.</td>
</tr>
</tbody>
</table>
| KeyConfigure does not display the latest installed version of DNASTAR Lasergene after upgrading from a previous version | After updating from a previous version of Lasergene, KeyConfigure may continue to display the previous version number. To correct this issue:  

   1. From the KeyConfigure Products Window, double-click on a DNASTAR application to display its Product Details window.  
   2. Change the version field to the correct version.  
   3. Close the Product Details window.  

Repeat steps 1-3 for each of the other affected DNASTAR applications.  

For more information, see the KeyConfigure online help. |
Install ArrayStar on a Macintosh machine

The ArrayStar application is part of Lasergene, but can only be installed on the Windows operating system. It is omitted in standalone or client installations to Macintosh machines. However, if the Macintosh is running Windows on Parallels Desktop, you can perform a Windows installation of Lasergene, allowing the Macintosh user to access ArrayStar. The following topics describe the steps that must be taken prior to the Lasergene client installation.

Step 1: Download and install Parallels Desktop

If you have not already installed a supported version of Parallels Desktop:

1. Go to the Parallels Desktop website and follow the on-screen instructions to complete the purchase and download of Parallels Desktop.

2. After the download is complete, double-click on the Parallels Desktop disk image (.dmg) to open a window containing the installer app.

3. To launch the installer, double-click Install. Follow the on-screen instructions until the Installer notifies you that you successfully installed Parallels Desktop. Click Close to complete installation.

4. To start Parallels Desktop, open Applications and double-click Parallels Desktop.

5. Activate Parallels Desktop. The activation key will be in your email.

For more information, see: Parallels Desktop / Installing Parallels Desktop

Step 2: Download and install Windows

If you have not already installed a supported version of Microsoft Windows:

1. Go to the Microsoft website.

2. Download of the Full version, not the Upgrade version, of the current edition of Windows. We recommend choosing the Windows Professional edition.

3. Follow the on-screen instructions to complete purchase of the software.
4. Start the Download Manager and download will begin.

* Wait until the status of the download is "finished" before exiting. For users with average download speeds, this download may take several hours to complete.

5. Open Parallels Desktop and select **New Windows Installation**.

6. Follow the on-screen instructions to install a supported version of Windows on your Parallels Desktop. The Virtual OS will reboot several times during this process. This will not affect the Mac operating system.

7. After Windows is successfully installed, the Parallels Desktop icon will appear in the Mac dock. When you open Parallels Desktop for the first time, you will be in the "Extended Coherence" mode. You may change this mode using the **Mac Menu** bar in the Parallels Desktop's **View Menu**.

* Microsoft recommends that you always run antivirus software and keep it up to date.

**Step 3: Configure Parallels Desktop**

Configure Parallels Desktop as follows:

1. Go to the Parallels menu bar on the Mac machine and select **Virtual Machine > Shut Down**.

2. Go back to the Parallels menu bar and select **Virtual Machine > Configure**.

3. Click on the **General Tab**.

4. Change the number of CPUs allocated to your Parallels Desktop to half the total that your Mac computer has. For example if your Mac has 8 cores available, choose 4 cores.

5. Change the **Memory** to 8GB by typing **8000** in the text box or sliding the arrow to the right.

6. Click on the **Hardware tab**.

7. Select **Hard disk** in the menu of the left side.

8. Click the **Edit** button and then change the hard disk size to at least **100GB**.
9. Select **Network** in the list on the left.

10. Change type to **Default Adaptor** in the drop down menu under **Bridged Network**.

11. Click **OK**, then **Windows ‘x’ Click here to start** on your Parallels Desktop (where ‘x’ is the version number).

**Step 4: Install DNASTAR Lasergene**

Follow the steps in *Standalone and network client installation for Windows*.
## Move Lasergene to another computer

If you move your licensed copy of Lasergene to another computer, you will need to uninstall the copy on the original computer. Before initiating the “uninstall” procedure, you must manually move any user-generated files from SeqBuilder Pro to the new computer or they will be lost.

The list below shows the files you need to copy and their locations. Be sure to move the files to the same location (file path) on the new computer. If you have never added to the Feature Library or Cloning Vector Catalog, you do not need to move these files.

**Note:** Depending on your computer’s operating system, some of these files may be hidden by default. Instructions for revealing hidden files can easily be found online.

<table>
<thead>
<tr>
<th>Item</th>
<th>Windows location</th>
<th>Mac location</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User-generated feature libraries</strong></td>
<td>C:\Users\username\AppData\Local\DNASTAR\UserFeatures.library</td>
<td>/Library/Preferences/DNASTAR/UserFeatures.library</td>
</tr>
<tr>
<td><strong>Vector catalogs with user-added vectors</strong></td>
<td>C:\Users\Public\Documents\DNASTAR\Lasergene ‘x’ Data\CloningVectors.sbp</td>
<td>/Applications/DNASTAR/Lasergene ‘x’ Data/CloningVectors.sbp</td>
</tr>
<tr>
<td><strong>User-modified enzyme (Enzymes.ezd) and selector (EnzymeSelectors.sel) files</strong></td>
<td>C:\ProgramData\DNASTAR\DataManager\1.0</td>
<td>/Library/Preferences/DNASTAR/DataManager\1.0</td>
</tr>
<tr>
<td><strong>User-modified SeqBuilder layout templates</strong></td>
<td>C:\Users\username\AppData\Local\DNASTAR\UserDefault.lyt</td>
<td>/Library/Preferences/DNASTAR/UserDefault.lyt</td>
</tr>
</tbody>
</table>

In the above file paths, ‘x’ represents the Lasergene version number.
Network license server administration

The topics in this section are designed to help an IT department (or similar) to administer the DNASTAR network license server.

- Restart, stop and uninstall the license server
- Verify license server status
- Monitor how many licenses are checked out to whom
- Troubleshoot client access to the license server
- Obtain an audit report of Lasergene usage
- Purchase additional uses or license additional applications
- Access additional administrative tools for managing the network
## Restart, stop and uninstall the license server

<table>
<thead>
<tr>
<th>Task</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Restart</strong></td>
<td>Navigate to <strong>Control Panel &gt; Administrative Tools &gt; Services</strong>. On the list, right-click on <strong>DNASTARLicenseServer</strong> and choose <strong>Restart</strong>. After restarting, check <strong>WlmAdmin</strong> to confirm the server is running with the correct number of modules and licenses.</td>
<td>Double-click on <code>/Library/ Application Support/ DNASTAR/License Server/start_ls.command</code></td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>Navigate to <strong>Control Panel &gt; Administrative Tools &gt; Services</strong>. On the list, right-click on <strong>DNASTARLicenseServer</strong> and choose <strong>Stop</strong>.</td>
<td>Double-click on <code>/Library/ Application Support/ DNASTAR/License Server/stop_ls.command</code></td>
</tr>
<tr>
<td><strong>Uninstall</strong></td>
<td>Use the uninstall utility located in <strong>Control Panel &gt; Programs &gt; Uninstall a Program</strong>.</td>
<td>Double-click on <code>/Library/ Application Support/ DNASTAR/License Server/ uninstall_ls.command</code></td>
</tr>
</tbody>
</table>
Verify license server status

On Windows:

1. Launch `WlmAdmin.exe` from `C:\Program Files (x86)\DNASTAR-LicenseServer\Admin\`.

2. Choose `Edit>Defined Server List`, add the IP address of your Server, and click `OK`. Then click the plus sign (+) next to `Defined servers`.

3. In the ensuing list, click the plus sign (+) next to your server.

4. Click on any of the modules listed, then look on the right side of the dialog to find the `Feature Information` section (under `Statistics`).

5. Confirm that the “Total” column contains the correct number of uses. Confirm this with all the modules, including Lasergene 6.


7. Find “DNASTARLicenseServer” on the list and make sure it is `Started`.

On Macintosh:

1. Open the Terminal and enter: `/Library/DNASTARLicenseServer/lsmon x.x.x.x`, where x.x.x.x. is the IP address. A string of text will appear, broken into sections based on the total number of modules plus one. Lasergene will be one of these sections. Each section will list the module and the “Max concurrent user(s)."

2. Verify that all the correct modules and correct number of uses appear on the list.

3. Navigate to `Applications > Utilities > Activity Monitor`. Look at “All Processes” to verify that `lserv` is running.

*“6” is part of the feature name, which is the same for all versions, and does not reflect what version you are running. For example, versions 9 and later clients can be run from a version 6 server.*
Monitor how many licenses are checked out to whom

You can use the server to get a snapshot of who is currently using the licenses and how many are checked out.

From the Windows Start menu, find and select All Programs > DNASTAR License Server > Administer License Server. Find your server in the list on the left side. The right side of the window will provide information about your license and who is using the software at that instant. Use View > Refresh to get updated information.
On Macintosh, the utilities are located in `/Library/DNASTARLicenseServer`. The utility `lsmon` provides similar information to `WlmAdmin.exe`. On Macintosh, drag and drop `lsmon` into Terminal (usually located in `/Applications/Utilities`), enter a space, then type `localhost` to find all of the information about the server. Or enter the following command:

```
sudo /Library/DNASTARLicenseServer/lsmon localhost
```

Note that for Lasergene, each application will appear followed by the number 6 (e.g. GeneQuest 6), however this does not reflect the version of Lasergene you are running. For additional information, see 

[Verify license server status](#).
Troubleshoot client access to the license server

Troubleshooting topics that deal with client access to the license server are:

- Error message ‘All licenses are in use’
- Error message ‘Cannot connect to License Server’
- License Server’s IP address has changed
Error message: “All licenses are in use”

Clients may receive the message "All licenses are in use" even though some licenses are available. This is because licenses may not be released if a client shuts down or reboots their computer without closing a DNASTAR application. There is a two hour timeout period before these 'inactive' licenses are released by the server. For more information, contact support@dnastar.com.
Error message: “Cannot connect to License Server”

If clients get the message "Cannot connect to license server" it is likely being caused by one of the following:

- The client machine is no longer connected to the network. To verify, try launching a web browser and connect to an external website or use a different application to open a file that is on your network.

- The license server machine is down or the service is not working. To remedy, restart the license server machine.

- A new security patch or firewall prevents the machine from locating the license server. For information on allowing clients to access the server through a firewall, see Handle a firewall on the license server machine.

- The license server machine does not have the same IP address or name. If the IP address or name has changed, this information will need to be changed in the lshost file for every client machine. lshost is a text file that can be opened and modified with a text editor like Notepad or TextEdit. For Lasergene clients, the filenames are LGx.lshost, ASx.lshost, and NG'x'.lshost, respectively. See Installed Lasergene file locations for the locations of the .lhost files.
License server’s IP address has changed

If you have performed a network installation and the IP address of the license server changes, you will need to update the IP address on the client machines. Launch DNASTAR Navigator and click on the License Manager application. Enter your server’s new IP Address or Hostname and click Authorize.
Obtain an audit report of Lasergene usage

A usage log file is automatically created by the DNASTAR network license server installer. By default, the maximum size of the usage log file is 1 megabyte. Also by default, once the maximum size of the file is reached, the license server will create a backup log file. The maximum number of backup files is 99. To display the information into a readable table:

**On Windows:**

The log file dnals.log can be found at `C:\Program Files (x86)\Common Files\DNASTAR-LicenseServer`. Open a command window by going to the Start Menu, typing `cmd` in the Search field and then clicking Enter. Enter the following command:

- `C:\Program Files (x86)\DNASTAR-LicenseServer\Admin\lsusage.exe -l`
- `C:\Program Files (x86)\Common Files\DNASTAR-LicenseServer\dnals.log`


**On Macintosh:**

The log file `DNASTARLicenseServer.log` is located in `/Library/Logs`. Open the Terminal, usually found at `/Applications/Utilities`, and then enter the following command: `sudo /Library/DNASTARLicenseServer/lsusage -l /Library/Logs/DNASTARLicenseServer.log`

The Usage Summary report can be limited using other variables such as a date range. See the file `documentation.html` installed with your license server for more information.

**On Windows:**

Open `C:\Program Files (x86)\DNASTAR-LicenseServer\Documentation\documentation.html`. Select the topic `About the Sentinel RMS Utilities>lsusage`.

**On Macintosh:**
Open /Library/DNASTARLicenseServer/documentation.html. Select the topic **Administrator Commands>lsusage-Display the Sentinel RMS Development Kit Usage Log File.**
Purchase additional uses or license additional applications

After contacting your DNASTAR representative and placing the order, you will need to reauthorize the server. (No changes will be required for the client machines). To reauthorize the server, launch the LicenseManager application from the following directory:

- **Windows**: C:\Program Files (x86)\DNASTAR-LicenseServer\Server
- **Macintosh**: /Library/DNASTARLicenseServer

Enter the Product Key provided by your DNASTAR representative. After successful authorization, restart the service to ensure the changes are in effect.
Access additional administrative tools for managing the network

For existing KeyServer customers, DNASTAR offers a KeyServer-compatible version of Lasergene. For details, please contact DNASTAR.

Once you have received a KeyServer authorization email from DNASTAR, proceed to Install Lasergene on KeyServer systems.
# Installed Lasergene file locations

The following file names use ‘x’ to represent the version number.

<table>
<thead>
<tr>
<th>File Category</th>
<th>Application</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ArrayStar (Win)</td>
<td></td>
<td>Windows: C:\Program Files (x86)\DNASTAR\Lasergene x\ArrayStar</td>
</tr>
<tr>
<td>SeqNinja (command line; Win)</td>
<td></td>
<td>Windows: C:\Program Files (x86)\DNASTAR\Lasergene x\SeqNinjaCL</td>
</tr>
<tr>
<td>Navigator (Win)</td>
<td></td>
<td>Windows: C:\Program Files (x86)\DNASTAR\Lasergene x\Navigator</td>
</tr>
<tr>
<td>All others (Win) and all Macintosh</td>
<td></td>
<td>Windows: C:\Program Files (x86)\DNASTAR\Lasergene x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Macintosh: /Applications/ DNASTAR/Lasergene x</td>
</tr>
<tr>
<td><strong>Data Manager (DMx, DMx.exe)</strong></td>
<td>SeqBuilder Pro, Protean 3D, GeneQuest, MegAlign Pro</td>
<td>Windows: C:\Program Files (x86)\DNASTAR\Lasergene x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Macintosh: /Applications/ DNASTAR/Lasergene x</td>
</tr>
<tr>
<td><strong>Data Manager State File</strong></td>
<td>SeqBuilder Pro, Protean 3D, GeneQuest, MegAlign Pro</td>
<td>Windows: C:\Program Data\ DNASTAR\DataManager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Macintosh: /Library/ Application Support/ DNASTAR/DataManager, /Library/Preferences/ DNASTAR/DataManager</td>
</tr>
<tr>
<td><strong>License Manager</strong></td>
<td>All</td>
<td>Windows: C:\Program Files (x86)\DNASTAR\License Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Macintosh: /Applications/ DNASTAR/License Manager</td>
</tr>
<tr>
<td><strong>Server License File (lservrc), Server License Manager</strong></td>
<td>All</td>
<td>Windows: C:\Program Files</td>
</tr>
<tr>
<td>(DNASTARLicenseManager), Server Executables (lserv, lservnt.exe)</td>
<td>(x86)\DNASTAR-LicenseServer\Server LicenseServer</td>
<td>Macintosh: /Library/DNASTARLicenseServer</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Standalone &amp; Trial Licenses (<em>.license), License Server Client License (</em>.lhost), Key Server Client License (*.keyhost)</td>
<td>All</td>
<td>Windows: C:\Program Data\DNASTAR\Licenses</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Macintosh: /Library/Application Support/DNASTAR/Licenses</td>
</tr>
<tr>
<td>Preferences</td>
<td>Protean 3D, Navigator, SeqNinja (DNA*), GenVision Pro</td>
<td>Windows: C:\Users&lt;user&gt;\DNASTAR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Macintosh: /Library/DNASTAR</td>
</tr>
<tr>
<td></td>
<td>ArrayStar</td>
<td>Windows: C:\Users&lt;User&gt;\AppData\Roaming\DNASTAR\ArrayStar</td>
</tr>
<tr>
<td></td>
<td>All others</td>
<td>Windows: C:\Users&lt;user&gt;\AppData\Local\DNASTAR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Macintosh: /Library/Preferences</td>
</tr>
</tbody>
</table>

*AppData is a hidden folder in Windows. To unhide the folder, go to Organize > Folder and Search Options > View > Show Hidden files and folders.*
Types of Lasergene licenses

A Lasergene license is based on the installation type, number of users and on the type of anticipated usage (e.g., a standalone license for research use only, a site license for professional use, etc.).

By usage type:

<table>
<thead>
<tr>
<th>License Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial/Research</td>
<td>Applies to commercial users that are involved in research.</td>
</tr>
<tr>
<td>Commercial Services</td>
<td>Applies to commercial users that provide sequencing or diagnostic services for outside clients.</td>
</tr>
<tr>
<td>Academic/Non-Profit</td>
<td>Applies to most academic, governmental, and non-profit users.</td>
</tr>
<tr>
<td>Educational</td>
<td>Available on a per-semester basis to those teaching Lasergene software usage to students in a classroom setting.</td>
</tr>
<tr>
<td>Free Trial</td>
<td>Results obtained with this type of temporary license may not be used in publications.</td>
</tr>
<tr>
<td>Added Value</td>
<td>Includes access to the following databases: Variant Annotation Database (ArrayStar), Transcription Factor Database (GeneQuest), Transcript Annotation Database (SeqMan NGen / SeqMan Pro).</td>
</tr>
</tbody>
</table>

By installation type and/or number of licenses:

<table>
<thead>
<tr>
<th>License Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standalone</td>
<td>Allows installation of Lasergene on a single computer with full-time access to the programs.</td>
</tr>
<tr>
<td>Network</td>
<td>Allows you to install a license server on any Macintosh or Windows computer. The license server limits the number of simultaneous uses to the number of systems you purchased. Therefore, you can install the client software on an unlimited number of Macintosh or Windows on the same network as the license server. This computer must be running constantly so that all client machines will always have access to the client software. Also, the server computer must have a static IP address, manually configured in the TCP/IP settings of the network card on that server. In addition, if one computer is running two or more applications this computer would count for only one simultaneous use. Therefore, if you had a 3 system network, you would have 2 more uses left.</td>
</tr>
<tr>
<td>KeyServer</td>
<td>Allows you to run Lasergene on an existing KeyServer network.</td>
</tr>
<tr>
<td>Site</td>
<td>Via a negotiated agreement, organizations can request a large number or an unlimited amount of</td>
</tr>
<tr>
<td>Cloud</td>
<td>Lasergene licenses.</td>
</tr>
<tr>
<td>-------</td>
<td>---------------------</td>
</tr>
<tr>
<td></td>
<td>All DNASTAR software can be licensed to run on the <a href="#">DNASTAR Cloud</a>, a service offered through Amazon Web Services’ <a href="#">Amazon Cloud</a> that allows you to access DNASTAR Lasergene software online from anywhere in the world. Flexible term licenses for the Cloud are available to meet your specific needs. Alternatively, you may set up your own account with AWS and create an access key to use the DNASTAR Cloud. Click <a href="#">here</a> for information on the DNASTAR Cloud Desktop, DNASTAR Cloud Assemblies and DNASTAR Cloud Data Drive.</td>
</tr>
</tbody>
</table>